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EgE)
223 JDeveloper Subversion VCS ¥ @

JDeveloper Subversion VCS #JE#T JDeveloper Aif=hRAC 10.1.3.0. 4. LK FE J2EE 5% Studio fiX; IIGAERKMA D
Java fit. WREM A TEIF 2% JDeveloper 10.1.3 (J2EE 8¢ Studio) , &M http://otn. oracle. com/products/jdev TF#.

JDeveloper Subversion VCS #"ER] M Oracle B 703G, BT LMEH Help 3EEF A Check for Updates IHAERZeILTH
e

http://mww.uml.org .cn/pzg1/200704054.asp 115


http://www.uml.net.cn/
http://www.uml.org.cn/
http://otn.oracle.com/products/jdev

2014493 11H

Help

Start Page
Table of Cankents

Crvnarmic Links

Full Text Search

Index

Fawvarites

Cue Cards {Guided Steps)
Tutorials on QTR

Samples on OTH

Cracle Java Education

Ask For Help
Cracle Technology Metwaork,

Release Mokes
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Ahout

f#F] Check for Updates [A]%, ##Z& Official Oracle Extensions and Updates H.l»:

(@) Search Update Centers:

Official Oracle Extensions and Updates

http: fihtmldb. oracle. comfplsfotn)f?p=updatecenter :uc
|:| Open Source and Partners Extensions

htkp: f e, oracle, comftechnologyfproducksfjdev10, ..

Bk FE Subversion VCS Extension M. %L H 5k VCS Framework Extension FE#T.

7 JDeveloper H11# | Subversion-UMLE {1 TREH Z3- kg S a4

Available Updates: [ ] Show Upgrades Only

From center: Official Oracle Extensions and Updates
[] oracle 3ava Data Mining {0JDM) 10.2.0.1

This extension provides oracle Java Data Mining library for QDM A,

From center: Official Oracle Extensions and Updates
Subversion ¥C5 Extension 10.1.3.38.65

Subwersion WS Extension including Javasyi

Frorn center: CfFficial Oracle Extensions and Updates
¥(5 Framework Extension 10.1.3.38.65

Provides Versioning Framework Support

Frorn center: Official Oracle Extensions and Updates

(8

Details

¢

Details

¢

Details

S

HEAN T I B

Downloading Updates

Downloading WCS Framework Extension { 52,50 KB of 159,66 KB )

TEEE, ERE S AMEET, KR EE

[Eh-Mew Extensions
L-Subversion YOS Extension version 10.1.3,38.65
E---Upgraded Extensions

L. MCS Framework Extension version 10,1.3.38.65

mF5E R, ATRES MG R B EHSIES JDeveloper:
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Confirm Exit X
To finish installing updates, JDeveloper needs to reskart,
) Do you want ko restart now?
es ] [ Mo
iﬁ% “ Yes » .

24 JDeveloper HJHJG, I Versioning ZH, ## Select Version System, #RJ5#EFE Subversion.

WREEE Y, ER S AR T E BPRESH R .

= Structure =]

4 subversion version swstem active
e ——

TERLE RN, WAE Subversion WL, KA JavaSVN 7 i e M % 3%: #TH Preferences XEHE (Tools >
Preferences), RIGIEA Wk Ti%k#E Versioning | Subversion.

2Ry )G, KA B DU R B

Versioning: Subversion

Subwersion Client:
Javashh 1.0.6 (http:/ftmate,org/svn)

EIgcy
ERE Subversion 15 HJE
Subversion {3 BB R FAT A B BUE .

RS R Subversion YENRASTEHIRSE, WTATLAAE JDeveloper HH¥i%H:1%{5 B ZE. £ Subversion Navigator (View >
Subversion Navigator) ', F#Hd; Subversion T, RJ5i%E+F New Repository Connection. fE Create Subversion
Connection FFEHEHY, {5 HIE MKV R 7P (http:// https://s svn://s svntssh://) FNSEEME . LR LUEH
file:/// WM, RIXREMRAR E 3 Homb A, anbftsg — ik .

or: WREEMFHAARIT RN SIEE P RG], WFHEZE NN c:/svn-repos WA Subversion {2, I
H svn:// W52 ERE. WRERZ2REE B Subversion &/ u#t, W JDeveloper Subversion VCS M JEd4 A
VB 23— AN A E B E . S RAIEA M Subversion {5 EE.

WREELRAF Subversion {FEEEERMEMEE, LMEREMELE LS FBUEHAMMLAE FAEA, JUTT LK 2845 B 5 H B — AN SRSk
o LS, BRTLoEE A SR NI SR VEAR{E Bk E @ . T T H#E, 15 /E Subversion Navigator WA##Hd Subversion 75
M, SRJE1EH Export Connections. 58 Export Subversion Connections XiiHE, SRJGHd 0K. BN AP EBT SN IEZEEAE
B, 5488 L Subversion WA, #RJE%FE Import Connections. iHi¥ Import Subversion Connections XfiHHE, U360 & &4
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S NFEREAE RS, SREHRT 0K,

(EE]
¥ JDeveloper WH S A Subversion

SR T AR RG], HIE—NE Java MABFABH, ZIHBEE—A Java BFORHBAFELRE Java K. §
c:\jdev1013\jdev\mywork\test fENIMHN E.

ot
i

Application Mare:

| TestApplication |

Directary Mame:
|c:'l,ju:le'u'lDlS'\jdev'l,mywork'\test || Browse. .. |

@ Applications
EI eskApplication. jws
El JavaProject.jpr
-1l javaproject

....... @ Class1 Jjava

....... E .:|.3552.ja'-'a

IEAEH R Subversion HWMHEZ AT T JDeveloper HFEJEMI M (AN iR fE) ST AN Subversion {5, R/FHMELFZH, Xt
B ST OB R “ TAERIAR”

kg JDeveloper HJ Import to Subversion [A]SKSGANIA JDeveloper WiH .

FETFUR T, S ERIE R A4 JDeveloper WIH M Subversion {5 EEMALE. X T AR EMHMRE, #H 77— URL, W0TFHT

AN
svn://localhost/

A ANHHREERER JDeveloper BAFRRFIE HRMIALE, (EIRCKRIEE S0 EFCRE. AR, AV KRG

R
c:\jdevl1013\jdev\mywork\test

B AR R EE S AN JDeveloper NAHFEFEINEH (FEAMIFZ TestApplication) JEBNFTF, SRJ5iEHE Versioning >
Import Files. IX¥JFJ5 Import to Subversion ]S,

fE Destination TUIH L, #if# Repository Connection MEMLEEAATEIEMEEER URL (BUEEALRR, WMREEHEE)

Repository Conneckion:

|svn:,|',|'|u:u:a|hu:ust - |

Path: ﬁ

BE, BRIZEEEEPIEFESASWME. S TAEE, BOat@E T M= aE, Bk, BIETLURE Path &
N “root” .

£ Source UM L., #ifR Source Directory HEGEEH) JDeveloper NHIFERHIE HRHIMLE . X TASRR HHIRY], % HRMiZ

2

Source Direckory:

| Cjdev 1013 jdevimyworkibest

IEANLAE Filters DU _EiEATALT B 4.
1F Options WH_E, #ffcik Perform Checkout HiEHE:

Perform Checkout
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By Finish S8RMCRAERAE,

JETT TestApplication 7l KE T I A, T LAE 2 UL ALEL

Applications
EIJE=:| estApplication 1
E@ JavaProject [localhost]
Elg:l Application Sources
=&l javaproject
------ u’@ Class1.java 1
(- 6@ ClassZ.java 1

BT v S RIS, RIS BoRE S o, B — MRS

£ Subversion H1, FRACTIEMEEENME BET AR E A R STIFIRAS . Bk, SCIFSFANRA SRR IZSI Mg . f£%
NHTEE AR RS, T SCIFBIRA SR BN “17 o BURSANEERE, WA SRAREHE S ERNBE WREE, B HRSAT
PRI RRA S R AR AP

£ JDeveloper H7, #idfF Application Navigator Hfq%eath 3%+ Versioning > Properties, %A LCLH BZCHHIAR
EN Y

MREEE TR SR ENSRSESER (20 Tools > Preferences | Versioning | Subversion | General) , M
] LG B 78 S RRACIRAS /NRE 5 o Bilhn, i 6 5 BBl 5w SOt B R IRTEAS B R BEE fE R s o .

PUERTLATE Application Navigator EZIHILMSE Subversion “TAERIA” SCfF, #EEER AT LMER EAT.
[EPiN=}
25 A

CEEH” MBS AN Subversion {5 EEE AR B SRS A S R GG A HO B AT B AT BT S5 o AR B Y IE R X S A7 A T
Subversion {8 BJESMIAHLE]A .

R EH Import to Subversion [A S ikH T Perform Checkout [S, NEZZH SN,

Bilhn, EMSL TR ANEAEZH S, 57E Subversion Navigator 1, FEHiEET B (TERBIFA svn://localhost) , AJFIE
# Check Out. FANEEMRT mEH . RAXNEHCHEW—MIE . N T #RSERN RAEIER— M R SCHARE, &
HFRHESCA c: /work, ZRJEHT 0K,

ITE, #EM Subversion {5 EFEEAHIISCHRE HBITE Application Navigator 9, EA155UA—MRAES.

Applications
El@ estApplication 1
El@ JavaProject [localhost]
EIE:I Application Sources
=&l javaproject
------ 6’% Class1.java 1

(Bl B
T I 58 S A

MA8AE JDeveloper HBIEBT SCHERS, QiSRS FHAF AR I DIRE, A R N REERAEHEAT, WA eA T3]
Subversion ##ff. N, WFEEMER JDeveloper ) Add @4, ZR/G{FH Commit 4.

7f Application Navigator H', QIEE—ANHIHI Java X (Class3. java) EARRAIE N AR B—iB 5.

El@ Testapplication 1
=- Jn"=;| JavaProject [localhost]
ElE.:I Application Sources
=&l javaproject
------ u"-_‘gl Class1.java 1
- ------ u‘@ ClassZ.java 1

------ n@ Class3.java
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1N

TRER, e ER 2 RA AT RN AR XL, XRR, BITRAZEH REAMEZN, BRZFINE.

TEMRINZRT, REE JDeveloper T.H, % T HMHEIEICF RIS BEHATIIMAEN. WREMAKRHT Pending Changes H I,
Hilid %% Versioning > Pending Changes HKJIFHE. iZ& LK) Candidates EIN-KEEAH AN, XEREASEIEREITHE

B FRHATETIR, BOREER, Hhlm CEGIERISCE (Class3. java), HAREI “Not versioned” .

%Pending Changes l

w® +

Mame | Location Status
u@ Class3.java Cwork) JavaProjectisrcljavaproject Mot versioned

Outgoing: 0 | Candidates: 1 ]

AT AR ALK Class3. java ¥INE] Subversion 84, ERKMA T, Pending Changes & K& IFERET CEXHE BE TSI
FREAT TS, FFRVFEE R ARRIA (WEREITEX A .

Z% Class3. java W IN%] Subversion ¥&fF, EHAT FFIEIEL —:

« 7£ Application Navigator HiE#FRiZ 3 fF, RJ5%EFE Versioning > Add.
« {E£ Pending Changes & N 1ZCF, SRIGIEFE Add.
« fE Pending Changes & HHif#eiZcfh, AJEHdE Add Eix <.

L IRAE AT — TR T R NREHE, ST DS X AR ER A SO . — B, AR bR AR A N R A+ Y
@ Class3.java

KRR, HBIR Subversion FIIE AL, (HIZSMHEAN R BEMN—H . BAZIBONE BER—5, T LMEH
JDeveloper [ Commit #i4: fF Application Navigator F1i%#% Class3. java, #RJGik#¢ Versioning > Commit. X¥JF/E Commit
Resources XIEHE. #EATLAMEAHZIEHEA 1 Comments HESRIIR BN S SCHHIAT IOERAE . FEABIF, W LURINERE “Initial commit
of Class3. java” o IEEG AFIINCARTT LR, W DUE BIX Ly RE, I H e A LIE 8 B S AT H 0 A AN SR A& .

$eon: AT RINES, 9 TR AN BRI R LR R IR R AR, A8 B AE A SO 2 Bl TR 25 A

Bl 5

ER pais

CHHT RBAMSAES Subversion R SCAFFEDFIERE . BEOAHAB RN VB EBURRZ A TIEEE, BN EZHIT Z 8 1E.
fEaLA#i ] JDeveloper [ Update 435 3 (At

BRI S A RECAS T DURIIE AE B P 2 DA BO AR A . BINRGE SRR —NH R, EETERSEPAT RS

% Oracle JDeveloper 10g

svn: Commit Failed (details Follow):

svn: Your File or directory 'Class3.java’ is probably out-of-date

svn: The version resource does nok correspond to the resource within the
transaction, Either the requested version resource is out of date (needs to
be updated), or the requested version resource is newer than the transaction

roat (reskart the commit),
| Details ==
[ ok

o org.tigris. subversion, javahl. ClientException: Merge conflict during cormmit

ST LA FEEA TAERIA . A H R P, 803 1A S
T A, i Application Navigator FikfFiXeb A2 B, #R/GiE+ Versioning > Updates
o WRATCUEH S EAS SEOPSE, WS 01 B AR AR i 7 (o5 P 6’%, T SO N 24 SR RS R R TR I 25
o WERAEBDHSCHEI A RS, W MERRRAONRIS (5], IF RSN R A T, DL IR RS A RIS B R B . R
R PP RAMC BT GES BRI .
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EiNEy
i 1 S0P

AT ULE AR JDeveloper HERAMARL4H T B b gdE TARRIAC ST o 3 SOPFRISCASSCAF 32 m] DA A Psth) R GE b 2, DRI s ]
DA SCA i Ay SO AL BT . RITBAR A BRI AR HAd T H

YA BSOS AT BTN (A, ERMEE AR AR B RGP AR D o AT E I,
Subversion < HAMEMEBI A CETH K, HHIGIE JDeveloper HHEF AR IR A I IRAS DU BIUIX — A1

R BHIRIETLE JDeveloper FFHF|IAFHIBHIRG, W8S Application Navigator T.EA% Ef) Refresh %41
E’ao

WREZANTFRN RBERCIF— A, WABZE — AU ] BLBT 1 — AN R A R0 TAE R S 5 5 — MR AR TAE. Subversion
BENIZ — K B AR R TT AR B M B - A IR . PRI, SO RN TT R R RZSCH, Bdnzsert, RIaHH
HHEMIT RN FREAGIFE . Bk, RUPSENE ESEIER R, HER PRI, 77— REnR, RA1es
—AHERNRIRTT: GES BRI

LR A B LR B~ B I MR . (BB, TRR R BUESCIE, (EROCH, HOCIRIEN (B, AR
Bl BUESCHA 2B 1L ST R A BTSRRI A ' A2 SEIAT N R B, EBBUEMER. BIL, BB IA S A
PLEW A

i R R B 5 AT MR SO SCAE . (A Uk, AT R R B TR R S P e R
A

FEVRRAH JDeveloper th, BE SCHFOUR TAE B IRACHISCAF LIBUE. WA Subversion lock Ar4RILAUBE L. AR
RS, TR BE R BIh e

é" Commit Resources E]

Marne | Locakion |
[&] icon-refresh.prg  CriworkiJavaProjectisrcliavaproject

keep Locks

Comments:

| Help | | ()4 _‘ | Cancel |

TREBUE BORA, HARTF RN AT SR T3-S AT I e SO R AR i R B4 B8 4

BUEH] Subversion lock fir&8UE M, ELEM IR FRALL T4
svn lock [XfF#4] -m "[HEI"

BRERSCABE, A BL R A S
svn unlock [ff4]

BN

B 5 & BT
JDeveloper #EHLT BANLLESCHEII TR, BIACH ) s T HAIARA G s T B

P A i g s R
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AR s TR, ARl

o BRI
o B RLHIRAH R A IF B SR A T .
o SRRSO A EHT R A Z [R5

TEEFERE SRS, AT 2, R)E8d History BT

@Classl Jjava E]
Revision Filker: [.ﬁ.ll v] ? Eﬁ ﬁ % @ i E & {:}
Date | Author | Rewvision | Description |
16-Mar-2006 17 |
16-Mar-2006 17:56:38  jdoe | 4 Added results display
16-Mar-2006 17:56:06 E Local  Save
16-Mar-2006 17:54027 E Local Sawve
16-Mar-2006 17:53:44  jdoe E 3 Corrected line end
16-Mar-2006 17:53:22 E Local  Save
16-Mar-2006 1752113 jdoe E 2 &dded code For calculation
16-Mar-2006 17:51:00 E Local Sawve
16-Mar-2006 17:51:00 [ Local  Load External State
16-Mar-2006 17:28:30 jdoe E 1 Imparting JDeveloper application 'test’
Revision 4 - C:hwork) JavaProjectisrcljavaprojectiClass1 .., File on Disk - Class1.java (Editable)
package javaproject; package Jjawvaproject: z
public class Classl public class Classl
i i
public static void wain(3tring[] args) public static wvoid main(3tring[] args)
{ { ]
double price, tax: double price, tax;
price = 500; price = 500;
tax = 17.5; tax =
4 | ] Kl | D] [~
Source lDesign lHistu:ury ]

JETAREL S M ATER BT W IR ZA R AR T ERHEITINE (SELE Source IEIF LRI —F) o &aT U
AR PRI A A IREHET 1 g, WA SERI SR E] Source BIAR Lo X T HOBHEIT, A2 IIARAIAT AR H i A B 80F 22
Fto XTRIMETT, 22 Rl i R b RAT A B

Classl.java [Wiew-0nly) File on Disk - Class1.java (Editable)
double price, tax: double price, tax:
price = 500; price = 500
tax = 17.5; tax = 17.5;

brice price = price *(1 4+ tax/100): /.
Sidisplay results

' dystem. out.println("**% Product Pr

el out.println (" Co:

PIANTAR (8] () 25 RO RS S48 T Rkt REARAE . A RARTE BT BASFERT 5 L AT LURIR Ui 3R ) RS

http://mww.uml.org .cn/pzg1/200704054.asp 8/15
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price = price *[(1 + tax/ 100]);

Click to Replace Adjacent Difference
Fight click For ather editing options

IR AR AT AR, B UARF S R CREBRERS) Pl

Replace Adjacent Difference

Insert After Adjacent Difference

A P A P s TR

ARG S TR, AT UK SCAF B T RSCAS S5 2SO B A AR RRCAAT LA 300 T & A TT AN 6 SO TR R E 0 B .
ORISR RRASRE R LK. 60T BLEB SO PN TN A, BB — RO, Bk, oA s TRIGEM T &I 30 A .

BEEFEMEB S Z AN AS, WEAE Applications Navigator FRIEFZ M, SRG%ES Versioning > Version History.
A [ s 1 B S AT AR A s 7 s D SR, (HEA LR X A

o EAWAMRALEIRTAGE A, BET IS REBRERRAA S, (HE, iR, NALIREAZERSiEt. O
o ELORRRCAC IR 10 22 57 T DLEE L 58 W AN AE (B oR HHOR, B 5 2 RTINS AR B R 303

[e] 5L
fipt W 5%

ARSI FEAT A B LB AR AR, sk R B ERGEAEC, RIE B A B AR 5 15 S IR A AR R
fGle EXFEST, RESFILER, I HARMNEREIHR AN )G, SR SHUER & B —MmS 5] .

WREE T — AR RS, S IUCIRIOX S SE, SR A Rl IR AC BIE B E . JDeveloper Hft T —ANEIF T H. @
I AN R, fsn] DB IE T SCAR R SO R o . i v —3EdSCE R P 9% A TR B 575, IRl JDeveloper Al ikf&4878 Subversion
R 3 AT B8 et mT AR R v 5

B T SCACH SOAT o B

FEF= AL M R I T SCR I SO, BSOS, BRI N A AUE BT SO A 2 o IR A 2R i SRR 2 B IT . T T B
ABIER T AT Java SCOFRIFE—ATH IS FERETT 51 A PR .

$EE555E oRlne

Sfconflicting comment line

Ficomment line added

FrrreErr LTzl

PRI Sk AT BT, GRIERRIESIOR, JRHIEH —METSS . EIPRE 557 (AT HRR. R
HIPICE “255 " 1FSATR IR

HEFE I T Bk se, i51E Application Navigator Fik#0:, SRJGi%E#¢ Versioning > Resolve Conflictss

http://mww.uml.org .cn/pzg1/200704054.asp 9/15
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@Class&java E]

2t 4+ A

t3 (Wiew-Only) Fesulk of Marge Class3 java (view-0nly)

/fcomment line added public class Class3 | _.-"_.-"n::n:nnflin::tinn;t COMMETIT E

public class Class3 { public Class3() { public class Class3 { | ||
public Class3() { 1 public Class3() | I:l
} } }

} }

Kl g ] ] [=]

Source lDesign lHistu:ury lMerge ‘

MR & E BRI N . TR RoR BT g S . ETEMEBIZN A . A THARE S B A A N 2 12 N 2 1 TE A
B/ POEREEEIHEER GEMRBANMRIG, ARBESEN. BEWTUEERFENS. =TRSO PRSI T RkE
TR ERIER Y. K AR BFAERT 5 LT DU R BB @ W T RSN . R E AR AR, BT LU S B R s s
Blo TS mAIARIEE WA RES FECH AR BAF

BRMAIE, BUBAUERH [ Ssave HARAEFERTE K.
A ST R e R

B A e ki S CnER S RS IEARE S, AT LA Subversion 3R BHM S SO AE FRAN REZ AN IERA I SO, RIS A&
BN AT E . ik, S Application Navigator WIEFEAY, SRJGiEFE Versioning > Mark Resolved. RIS EFRM
s (& RNES G DIRORZBSISiE. HERZZIE (Versioning > Commit) W, Subversion & & FERIZRERZ L,
MAZ ERmRIELE.

[l B

= i 44 A
Subversion FOVFE fir 4 ZERLAAZHI IR, FFH JDeveloper SCIFXIATIRE.
HIEAE JDeveloper HE AT A CAFIS, K H i 441200 1F LL R HARTESCAF P IZA AR

4 Java JE X Class3. java BEAn44 N Classd. java, 1HfE Application Navigator Hik$% Class3. java, RjGiEFE Refactor >
Rename. X¥JF/H Rename XFififfE,

# Rename Class3 E]

Rename To: |E |

[] Search in Comments
Seatch Text Files
[ ] Preview

H#i4H (Class4) BmINE A (Classd) . BATFESGE XY B4 . PR EELETE S0P ES AR, HiEH Search
Text Files Ei%HE.

R MRBEEVATERNEE AREASE, EikT Preview HIEHE. HEHE 0K 5, HUEKE/RTE Log & H
o HERER—MEEEFEM Java XA BN . SO TES S — DS N RARE B W 4 AR sk
BIRTLAE Bdit & AT ER . RS RE a4 B AR, AT DU 000 SRS 25 08 el HE B A 590 i <2491«

http://mww.uml.org .cn/pzg1/200704054.asp 1015
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Rename javaproject.Class3 - Log
@ >

10 jawvapraject
B8] Class3.java
----- public class Class3 [
“opublic Class3() |

Messages -EE-Rename javaproject,Jass3

WIREIERE T Preview 1T, W LAMIELE Log % HHHd Do Refactoring %4l [B KM EMA .

INRIEBA SR Preview I, W/LH S OK WE#ATCIE4 . Application Navigator BUERIR, WZEMMT CGLAHARMA) JIf

R (FHEREE N IRBETXO B #8scits

E@ TestApplication 1
=1-53] JavaProject [localhast]
=15 Application Sources
-5 javaproject
b 6’% Class1.java 1
28] Classz java 1
o] @ Classd, java

£ Pending Changes & Ht, FA NS4RS CANMER TR, 10 BA B SO 4 0 ct 2AN G IR

%Pending Zhanges l

W 2 %

Mame | Location | Content Status |
I Class4java Ciwork)JavaProject|srchiavaproject Scheduled For addition
o Class3java  Cwork)JavaProject|srcljavaproject Scheduled For deletion

Cukgaing: 2 lCandidates: IZI]

BRI R, BE VRS ABIT Classd. java, HHREMRIFSM GERHZ R .

WRIEEE Classd. java IAHLJIE (7 JDeveloper WRFTHZICH:, HHiidi History IR , BHEBNZ SO Py s 4(5

YRHZ Class3. java W SLVE4E R

Pom s WAREARAS AT SR AL, AITHEE A, WA BER Revert frd. H4, REFEMAIM — WREA
RAF, R TiEGks:, RE, BREEGARI XM (Versioning > Revert). XA T Ear &2 X AR — A8
X (FE LR B2 Classd. java) o AT PIHERIZAS B SCH CInRIERED - BI7E, #3%) Pending Changes M, #F
BA IR AFRISCA:, REHATIE I . XFREE R AGSCHRE S Application Navigator, JFE A, H2, R,
X2 5 Ay 4 HAl SO RSO R S, T X e 5] PR Tk B el R AR AR . AU RIS ), IER AT T3l
e

Al B

M Subversion EM R 4
E

: M Subversion F&AHFHREER SCARET 2 AL HR IR R SR

F Subversion IEMEHRERR AL, BTESNIA IR CIE, SRJEERE Versioning > Remove.

# Remove from Subversion ['5_<|

MNarne | Locakion |

@ Class3.java  CiworkidavaProjectisrcljavaproject

] [
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RS 0K %4, Pending Changes % IHY Outgoing IR Z SO B N THRIMIRE :

%Pending Changes l
aa
W E %
Marne | Lacation Conkent Skaktus
@ Class3 java Cihwork) JavaProject)srcljavaproject Scheduled For deletion
Cutgaing: 1 lCandidates: III]

e WIS BB ARL, AITHBEBR M, 57E Pending Changes & HHUIESF M, ASFIEE Versioning >

Revert.

FM Subversion MR R A, i5AE Pending Changes & I ikFEcft, SRGiEFE Versioning > Commit. R INE]
Commit Resources XfiGAE, #RJGH#dF 0K. Z A M Subversion 15 BEME .. A TAERIA L JDeveloper [T AR EH S 1% .

EYE]
sk —: 2% Subversion % um At
%7 JDeveloper Subversion VCS ¥ JELAAN, #ADRIEAFM Subversion A, HLATIEBLERSH:

o BFHBEHH JDeveloper Subversion VCS ¥ JEGIZEAH: Subversion (g8 JE.
o BAHEMEH Java 46w (FHEHRE) MARLZY RIZHEN JavaSN,
o BAEEITAENRSS A ERS] Subversion (FEE (S BBk 4 EH 2] Subversion {58

7 LRFTERENT, EBRERERME) Subversion &t MBEHEMFHIAM Java g0, EFFEEI Rt (S %E
JavalL &) .

R FE T 3 Subversion & AA:, AILAM http://subversion. tigris. org $KIFULER] Subversion JFEAUHS L K4S &6 H)—
BRSO, 1BRZ%E3% Subversion 1.3, 2. WIHREMEH ARG ARTAE RS (W1, GNU/Linux 3L & A7 iR A B A5 F 16
Unix &R , WATLLEWEEN 0S HER R, sKARIHIEICID SR R P il itk

XFF Microsoft Windows, M http://subversion. tigris.org F#{ Subversion ZIEFEF svn-1.3.2-setup. exe. RJG, BITIZE
R, I Subversion & FEGMAE— AN ERIME, W c:\subversion. EAGE R, HHH— N8R, REEN svn
help., MPBEEEITHLYIE, BRERZEKEZGEET Subversion MZEEME (FIUWI, echo $PATHS MiZMEE

c:\subversion\bin) .
[EPig:y
M= e HAh Java HOHKE

JDeveloper fFE—MHHIZEE, 465 Subversion fFEEMTAERIAIATIE G, FHHIZEE JavaSVN GES W http://tmate. org) ¥
HZzI5 JDeveloper Subversion VCS ¥ B—R%3, EIAATLL%%E Subversion HAMEE, Bl JavalL. JavaHL 26 FIHLH &R DL
Subversion HIBIEEHEFFRALEY, M RFELESFPML (http://s https://s file:///s svn://s svntssh://) VikEEE,
RG24 T Javalll, JDeveloper WfiLfEikFE 2 i Javall I&Z&ffH JavaSVN.

7% Javall JE

JDeveloper AJLAYE JavaHL JFEM) 1.3.2 FrBic&{difH.
%FF Microsoft Windows:

B, WIRE P3N bin Hk GES%3E Subversion &/ ik fF) AT R4t L.

M http://subversion. tigris. org F#; JavaHL JFE (svn—win32-1.3.2 javahl. zip).

TR (i WinZip) BHMIERGHALE (40 c:\temp) .

1E Windows WVFEFRIEFIRAIMIESE H 3, W c:\temp\svn-win32-1. 3. 2,

% libsvnjavahl-1.d11 XHEHIF] Subversion %/ ut43EM bin H3EF, #0 c:\subversion\bins
BN ZEEN bin HRRAZA S DU S0

O = W DN =
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Mame Size  Tyvpe
.:;_l int3_svn.di 69 KE Application Extension
.jr] libapr. dll 125KE  Application Extension
.i:_] libapricary. dll 37 KB  Application Extension
.jj_l libaprutil, dll 165 KB Application Extension
.‘_5»] libdb3.dl 692 KB Application Extension
.j:] libeay3z,dl 1,036... Application Extension
.j—:] libswnjawahl-1.dll 939 KE  Application Extension
mod_authz_svn.so 109KE SO File
mod_day_svn,so 431 KE 50 File
.‘_f_l ssleay3z2. di 196 KB  Application Extension
SYNLEXE 913KE Application
synadmin. exe 449 KB Application
svndumpfilter. exe 397 KB Application
svnlook.exe 421 KB Application
SYNSEYE, Bxe 469 KB Application
SYNVErsion. exe 757 KB Application

ox: BAEENTEN EREA LR HARA . R, EH R R G AR TR AT AT T
Wi T45 1) Subversion SCAFHIIE. INAVENI/ERRAR T HHBLAIALR, Subversion 2R EA], HARE
AR, WREMR. Blan, WRMHT X ssleayd2. d11 FIAFRERA, KA REE “SSL
negotiation failed: SSL disabled due to library version mismatch” (SSL J@{F2¢M: SSL K ZERRA
AR .

Xt F GNU/Linux FEHAWE T UNIX MIEERS:

o WURER 0S RAMEHEFOERARL, BEMZRGRC, FifReR T Javall EXR.
o UARGEARIRIRAIG R 1E T Subversion 2% Ui, WA REFEEPATHSMNIE BRI RIGEE Javall FEXIR. W%, X
TEMM AL R4 : make javahl && make install-javahl

%t JavaHL FEBCE JDeveloper
WRIE RS T Javall FE, TEAFAIRCE 0S JRAEXN GURBE R L.

« X+ Microsoft Windows, WUREEAGASCAYATTHRANSER, W DLL MDA MN T RARRE b BERIFX— 8, HHF A
LR, IR R (echo wPATH), HRBERTEE DL KL JUHZ libsvnjavahl-1.d11) .

o XTHET ONU/Linux MRS, B UL root BB T “ldconfig —v | grep svn” o MHSREHRA B BT, 352 F AN
BSOS, TR A IR AE Y .

JABEE W G5 JDevelopers

FTH Preferences XiEHE (Tools > Preferences), RGIELE G T &L Versioning | Subversions

WERCIEM %% Javall, FE, BOKMEBIRMIFHKEEL:

Versioning: sSubversion
Subversion Client:
() Mative Client {jni, version 1.3.2)

() JavasyM 1.0.6 (http:/ftmate. org/svn/)

B Javall JE, &S Native Client &I,
R, WRELGM Oracle HH L HH JDeveloper Subversion VCS §fE, IE R E®IIE RN JavaSVN,
Epiy=)

M= WERIERFEHEE Subversion FRE
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IR A B I R EE R 45 25 %8 Subversion fZEFE, MIAFUL AL MM Subversion & Ui F. S %3% Subversion 7 i
WAE,

— B3 T Subversion &AM, #E Windows Application Data H3 Fat<exfi— Subversion T Ht. Z#FK Application
Data HI, WETE c:/ IR NN cd 2APPDATA%. #AJ5, #TJF Subversion FHI. (F£ Linux L, ZEMmT HIKA T
~/.subversion, P ~ BEFHZR. )

£ Subversion W1, FTHIFKR—MUN servers MIIF. MHASCARGEIRITIFZICM, RIFHKRE] [global]l XBt. M http-
proxy-host fTBBRIERIRC (), 2R MG RAIRS S0 RNEBE SR S FUEER. M http-proxy-port [THERIERR
e (), RJF AR R 25 2 0o 1 5 7 o A AP U5 2o PR A BB URL AMEFIREEAR 5548, 1M http-proxy-exceptions
IS (1), RJEHIIXLE URL A5 56245 URL.

PS5 P R A H A A R e 55 45 IO VRS B INBIAM . http-proxy-host Ml http-proxy-port 1T,

B, RERS 2SR Subversion MHMFTA http Aik. BRAER T, FELACHARS 28 A SR T /7% PROPFIND. REPORT.
MERGE. MKACTIVITY 1 CHECKOUT. 4nSR#R7Efd FIAREEARSS 28176 Subversion {5 B ZEIN B F o) 88, B DAEESR IR 28 1 R 404 BE G4 O 40
B, PISCfFXEE http k.

[EPig:y
Ff V0. GlEEAH Subversion {5 K JE

JDeveloper Subversion VCS ¥ @fl& — M EIE A Subversion 15 B EMIhAE. BT %Y & BT at (S B R, B Fises
BN Subversion & FuidkAt, A GEAMEA JDeveloper BIEEAMEEFE. %3 Subversion Z /Ui B E W% %% Subversion
% A

@A Subversion {EE )%, %P Versioning > Create Repository.

7t Create Subversion Repository XiEHEH, 2 NEMNHE BEME MBS RGERM. N T REERTER RG], &
I REBRAERSN c: /svn-repos. BTG RGRARE AN EE Native, AUNIRGLERELIK.

® Create Subversion Re pository E]

Create Repository N
Enter details for the new repositary, A connection —
will be created automatically.

Repository Path: |c:,|'svn-repu:us| |[ Browse, .. I

File Swstem Tvpe:  (3) Mative () Berkeley DB

Conneckion Mame: | |

e

AERECE G, B A 0EE R ERERE. EATUFE Subversion Navigator WA BXANERL.

@Suhversian Mavigator ] E]

® W

@ Subwersion
E file:ffic: fsvn-repos

File:fffc: fsvn-repos

WIRIEAEH JavaSVN, 7B 5 W 7iEHN file:/// BN http://s https://s svn:// B svntssh://. XEHICKEIE
Subversion CAYHHIR,

PR M T AT EHEZ AN NEBEA TR AR, svn:// U H, IFHSTRE. Ea2iniF T
A

svnserve —d -r [{5EEME]

TRAFAT A& T IT. A AE(E B ERERN, HH:

svn://[VHEHA]/
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fERME BIEALE

ST AT A RG], Ear SRR RN svnserve —d —r c¢:/svn-repos/, R4 % HFTHF. 7E Subversion Navigator
i, XWEFERELIR file:///c:/svn-—repos. fE Edit Subversion Connection XfiGHES, F svn://localhost/ Et5 Repository URL.
MiaESE, RJEHd 0K SCHIXTEHE .

A | BERRA] | Copyright 2002 ®  UMLHfF TR 5TICP#% 100209222

AWM Z4%1101080010715
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